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Introduction

This document describes the policy management and configuration of Workshare Protect and 
suggests best practice recommendations on how to create policies for user profiles across the 
Enterprise.  It looks at four key areas of analysis when creating Workshare Protect security policies:

1. User Profiles
2. Email Settings
3. Content Policies
4. Hidden Data Policies

This document should be used only as a guide in the deployment of Workshare Protect. 

User Profiles

When establishing content security policies for Workshare Protect, it is important to consider the 
role of users who distribute documents and content to gauge the risk based on their permissions and 
access to sensitive content.  Workshare Protect ships out of the box with a default policy 
configuration but this isn’t always suitable for different users and groups across the Enterprise. 
Therefore, individual policies should be created based on a user’s profile.  

Typical user profiles that are commonly seen across organizations can be described as follows:

Profile #1 Business Support Staff
User profiles who don't make key business decisions or are not accountable for these decisions

Profile #2 Manager/Supervisor/Normal Knowledge Worker
User profiles who occasionally make key business decisions but are not always accountable for these 
decisions

Profile #3 Senior Manager/Director/Advanced Knowledge Worker
User profiles who have some access to make key business decisions and are accountable for these 
decisions

Profile #4 Executives/Power User 
User profiles who are authorized to make sound business decisions and are accountable for these 
decisions

Workshare Protect policy configurations should be mapped to each users profile by determining any 
risk associated with the profile.  An example of a commonly used policy profile is set out below and 
is used for illustration only.

Workshare Protect 4.5 – Best Practice Policies
Deployment
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Profile #1
High Risk

Profile #2 
Medium Risk

Profile #3 
Medium-Low Risk

Profile #4
Low risk

Do not show options 
on send

Show options on send
Metadata: 

Do not show options 
on send

Do not show options 
on send

Do not show progress 
bar

Metadata: Clean all and 
allow override for all 
options EXCEPT: 
Comments, Track 
Changes and Hidden 
Text

Metadata: No 
cleaning

Metadata: No 
cleaning

Metadata: Clean all Content Filtering: 
Alerts on

Content Filtering: 
Alerts off

Content Filtering: 
Alerts off

Content Filtering: 
Alerts on

No PDF conversion with 
override

Password protect 
policy configuration

Allow access to policy 
configuration

No user override Skip cleaning disabled 
with no override

No PDF conversion Password protect policy 
configuration

Skip cleaning disabled 
with no override

Internal 
Recipients

Password protect 
policy configuration
Do not show options 
on send

Show options on send Show options on 
send

Show options on send

Do not show progress 
bar

Metadata: Clean all and 
allow override for all 
options EXCEPT: 
Comments, Track 
Changes and Hidden 
Text

Metadata: Clean all 
and allow override 
for all options 

Metadata: Clean all 
and allow override 
for all options 

Metadata: Clean all Content Filtering: 
Alerts on

Content Filtering: 
Alerts on

Content Filtering: 
Alerts on

Content Filtering: 
Alerts on

No user override PDF conversion with 
override

PDF conversion with 
override

No user override PDF conversion no 
override

Skip cleaning 
disabled with no 
override

Skip cleaning enabled 
with override

PDF conversion no 
override

Skip cleaning disabled 
with no override

Password protect 
policy configuration

Allow access to policy 
configuration

Skip cleaning disabled 
with no override

Password protect policy 
configuration

External 
Recipients

Password protect 
policy configuration
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Email Settings Policy
Email Settings enables you to configure policy on whether the user should be prompted before email 
attachments are cleaned of hidden data, as well as automatic zipping and PDF options.

The parameters are displayed in the middle area of the right pane. Selecting a parameter enables 
you to specify that parameter in the lower area of the right pane. For example:
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The best practice Email Settings policies are described in the following table: 

Parameter Description Best Practice

Automatically zip 
attachments 
above this MB 
limit when sent 
externally

This option enables you to specify the size limit for 
zipping attachments sent to external recipients. If 
this option is left blank, no zipping is done. If this 
option is set to 0, attachments are always zipped 
(unless they are already zipped). You can also set 
this value to a particular size, for example, 0.5. In 
this case zipping only occurs if attachments 
collectively are larger than 0.5MB. The default 
setting is blank, so automatic zipping does not 
occur.

NOTE: This action is invoked when at least one of the 
attachments is in one of the following formats: DOC, 
RTF, XLS, DOT or PPT.

Profile #1 = ON

Profile #2 = ON

Profile #3 = ON

Profile #4 = OFF

Automatically zip 
attachments 
above this MB 
limit when sent 
internally

This option is similar to the above, except that it 
applies to attachments when all recipients are 
internal. The default setting is blank, so automatic 
zipping does not occur.

NOTE: This action is invoked when at least one of the 
attachments is in one of the following formats: DOC, 
RTF, XLS, DOT or PPT.

Profile #1 = ON

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF

Password Protect 
Zip Files

When this setting is selected, users are prompted 
to enter a password whenever attachments are 
automatically zipped. This option is used in 
conjunction with the automatic zip options.

When this setting is not selected, zip files are not 
password-protected.

Profile #1 = ON

Profile #2 = ON

Profile #3 = OFF

Profile #4 = OFF

Convert 
attachments to 
PDF when 
sending email 
externally

When this setting is selected, and Show options 
when sending email externally is disabled, 
Microsoft Office documents attached to the email 
are automatically converted to PDFs when the 
email is sent externally. 

If Show options when sending email externally is 
enabled, the user can select at the time of the 
send if the documents should be converted or not, 
and overwrite the default option selected by this 
setting.

Profile #1 = ON

Profile #2 = ON

Profile #3 = ON

Profile #4 = OFF

Convert 
attachments to 
PDF when 
sending email 
internally

When this setting is selected, and Show options 
when sending email internally is disabled, 
Microsoft Office documents attached to the email 
are automatically converted to PDFs when the 
email is sent internally. 

If Show options when sending email internally is 
enabled, the user can select at the time of the 
send if the documents should be converted or not, 
and overwrite the default option selected by this 
setting.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF
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Parameter Description Best Practice

Show options 
when sending 
email externally

When this setting is selected, users will see the 
dialog box with options to convert to PDF or 
remove hidden data when they send documents to 
external users. 

When this setting is not selected, the user does not 
see any options, and the email is processed 
according to the hidden data cleaning and PDF 
options specified in the configuration settings.

By default this option is selected, so the dialog box 
is displayed when emailing to external users.

Profile #1 = OFF

Profile #2 = ON

Profile #3 = ON

Profile #4 = ON

Show options 
when sending 
email internally

When this setting is selected, users will see the 
dialog box with options to convert to PDF or 
remove hidden data when they send documents to 
internal users. 

When this setting is not selected, the user does not 
see any options, and the email is processed 
according to the hidden data cleaning and PDF 
options specified in the configuration.

By default this option is not selected, so the dialog 
box is not displayed when emailing to internal 
users.

Profile #1 = ON

Profile #2 = ON

Profile #3 = OFF

Profile #4 = OFF

Show Content 
Alert when 
sending mail 
externally

When this setting is selected, users will be alerted 
when they attempt to send documents externally 
that contain high, medium or low levels of hidden 
data. This parameter is selected by default.

Profile #1 = ON

Profile #2 = ON

Profile #3 = ON

Profile #4 = ON

Show Content 
Alert when 
sending mail 
internally

When this setting is selected, users will be alerted 
when they attempt to send documents internally 
that contain high, medium or low levels of hidden 
data. This parameter is not selected by default.

Profile #1 = ON

Profile #2 = ON

Profile #3 = OFF

Profile #4 = OFF

Allow users to 
skip hidden data 
cleaning

When this setting is selected, users are allowed to 
bypass all hidden data cleaning specified in the 
configuration for a particular email.

If this option is enabled, a “Skip Cleaning” 
checkbox is displayed in the dialog box that 
appears when users send an email.

If this option is disabled, the “Skip Cleaning” 
checkbox is disabled and hidden data cleaning 
specified in the configuration is enforced.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = ON
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Parameter Description Best Practice

Allow users to 
change advanced 
hidden data 
options when 
sending

When this setting is selected, the “Hidden Data” 
tab is available in the dialog box displayed when 
sending an email. This option enables the user to 
specify exactly which hidden data types to remove 
from an attachment.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = ON

Profile #4 = ON

Disable document 
security

When this setting is selected, email attachments 
and document restriction settings are not checked 
so users are not prompted to clean hidden data 
regardless of other settings.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF

Handle all 
recipients as 
external

When this setting is selected, internal recipients 
are no longer recognized. All recipients are 
regarded as external recipients and the same 
settings are applied for all recipients.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF

Show Send with 
Protect button in 
mail messages

When this setting is selected, a Workshare Protect 
button is included in the Standard toolbar of the 
email message window. When the user creates an 
email with an attachment, then clicks on the Send 
with Protect button, the Attachment Options
dialog is displayed, providing the user with the 
options to convert to PDF and clean hidden data.

NOTE: This button does not appear when Microsoft Word 
is the selected email editor. To configure this button for 
Lotus Notes, please visit the Workshare Learning Centre 
for additional configuration information.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF 
(optional ON if 
required)

Treat all email 
groups as 
Internal 
Recipients (Lotus 
Notes only)

When this setting is selected, Workshare Protect 
applies the internal settings to documents emailed 
to email groups. Both internal and external 
recipients within these groups will be treated as 
internal recipients. This setting is available for 
Lotus Notes only. 

NOTE: When this setting is selected, all external 
recipients within an email group will be treated as 
internal recipients.

Profile #1 = OFF

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF 
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Parameter Description Best Practice

Additional 
Internal Domains 
(Lotus Notes 
only)

This setting allows you to specify the names of 
domains that you wish to treat as internal. All 
email addresses within the specified domain names 
will be treated as internal recipients. All email 
addresses from domains not on this list will be 
treated as external recipients. 

To specify a domain as internal, enter the name of 
the domain in the field supplied. If you want to 
specify more than one domain you can do so by 
separating each domain with a semicolon. This 
setting is available for Lotus Notes only and is case 
sensitive.

NOTE: The domain of each user is displayed in a specific 
domain field in the Lotus Notes address book.

Customized for All 
Profiles

Suppress 
Progress Bars

This setting allows you to suppress the progress bar 
that will appear when cleaning and sending an 
email. This progress bar appears after a number of 
seconds when the Show options when sending mail 
externally and Show options when sending mail 
internally settings are disabled. This setting is 
disabled by default.

Profile #1 = ON

Profile #2 = OFF

Profile #3 = OFF

Profile #4 = OFF 
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Content Policies

Workshare Protect ships with best practice policies for identifying content risk in documents by 
searching for pre-defined keywords and regular expressions in elements of a document’s structure 
e.g. the words Confidential or For Internal Use Only in the header or footer of documents or credit 
card and social security numbers.  

The content policies are extensible to include custom keywords and regular expressions that may 
have specific sensitivity to an organization i.e. document classification schemes or matter and 
account numbers.  For more information on customizing Workshare Protect content policies please 
refer to TechNote: Policy Customization from the Workshare Protect Learning Center –
http://www.workshare.com/support

Hidden Data Policies

The Internal Hidden Data Removal and External Hidden Data Removal policies enable you to specify 
which hidden data should be removed from email attachments. There are two Hidden Data Removal 
policies: External Hidden Data Removal that includes parameters for external recipients, and 
Internal Hidden Data Removal that includes parameters for internal recipients. The parameters in 
both policies are the same but one set applies to internal recipients and the other applying to 
external recipients. Different settings can be set for each. You may want to remove all hidden data 
when sending emails externally, but only remove track changes and hidden text when emailing 
internally.

You can also select whether to allow the user to override these settings. When you select a setting, 
a checkbox to Allow users to override will appear in the lower middle pane. If you want users to be 
able to override your settings, select this checkbox. Otherwise, the user will be unable to change 
the setting. This checkbox is selected by default, therefore, administrators must uncheck the 
checkbox to lock these settings.

www.workshare.com/support
http://www.workshare.com/support
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The parameters are displayed in the right pane and are divided into High, Medium and Low risk 
hidden data. You select a parameter by selecting a checkbox to the left of the parameter. Selecting 
the checkbox to the left of, for example, High Risk Elements selects all the hidden data options in 
that category.

Workshare Protect ships with best practice High, Medium and Low risk elements but they can be 
customized to represent what elements are spefically sensitive to an organization.  The risk ratings 
can be modified by editing each High, Medium or Low risk element in C:\Documents and Settings\All 
Users\Application Data\Workshare\Workshare\metadatasecurityratings.xml.  For more information on 
customizing the Hidden Data risk ratings, please refer to the Workshare Protect Admin Guide.
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The best practice Hidden Data policies (both Internal and External) are described in the following 
table:

Parameter Description Best Practice

HIGH RISK

Accept All 
Changes And 
Turn Off Track 
Changes

Microsoft Word and Excel. If selected, 
accepts all revisions made to the 
document. The revisions are therefore no 
longer displayed as revisions but rather as 
text in the document. Track changes is 
also turned off so that further revisions 
are not tracked.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All 
Comments

Microsoft Word, Excel and PowerPoint. If 
selected, removes any comments 
embedded in the document.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All Text 
Smaller Than 
5pt

Microsoft Word only. If selected, removes 
all text that has been formatted with a 
font size less that 5pt.

Small text can be viewed in Microsoft 
Word by selecting Zoom from the View
menu and specifying a percentage greater 
than 100%.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All White 
Text

Microsoft Word only. If selected, removes 
all text that has been formatted with a 
font color of white and has no background 
color. 

White text can be viewed in Microsoft 
Word by selecting Options from the Tools
menu and selecting Blue background, 
white text in the General options section 
of the General tab.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All 
Hidden Text

Microsoft Word only. If selected, removes 
all text that has been formatted as 
hidden.

Hidden text can be viewed in Microsoft 
Word by selecting Options from the Tools
menu and selecting Hidden Text in the 
Formatting marks section of the View
tab.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON
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Parameter Description Best Practice

Delete All 
PowerPoint 
Speaker Notes

Microsoft PowerPoint only. If selected, 
deletes all the text that appears on the 
Notes pages in a PowerPoint 
presentation.

Speaker notes are usually used by 
speakers to remind them of points during 
a presentation. You may want to remove 
speaker notes before distributing a 
presentation, as they are not usually 
intended for others to read.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All 
Versions 

Microsoft Word only. If selected, removes 
any previous versions of the document 
that you may have saved. Previous 
versions can be useful while you are 
developing a document, but often they 
can contain confidential information that 
you have removed from the main 
document.

Previous versions can be viewed in 
Microsoft Word by selecting Versions
from the File menu.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Clear All 
Previous 
Authors

Microsoft Word only. If selected, removes 
information about all authors who have 
previously saved the document as well as 
save locations.

This information cannot be viewed from 
within Microsoft Word but it is visible 
from Microsoft Word if the file is opened 
in recovered text mode.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete Excel 
Links

Microsoft Excel only. If selected, converts 
external links in Microsoft Excel files to 
text. The following are examples of 
external links:

• Link to a cell in another Microsoft 
Excel document.

• Named link to a named reference in 
another Microsoft Excel document.

• Link to another document.

• OLE link that inserts another 
document as an icon.

• OLE link that inserts another 
document as text.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON
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Parameter Description Best Practice

Delete 
PowerPoint 
Hidden Slides

Microsoft PowerPoint only. If selected, 
removes hidden slides from Microsoft 
PowerPoint files. Hidden slides are not 
required for a slide show (they are not 
automatically displayed during a slide 
show) but they may contain confidential 
information.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Turn Off 
Autoversioning

Microsoft Word only. If selected, turns off 
the flag to automatically save a new 
version of the document every time the 
document is closed. Versions can still be 
saved manually.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

MEDIUM RISK

Delete All 
Custom 
Properties

Microsoft Word, Excel and PowerPoint. If 
selected, removes any custom properties 
that have been added to the document.

NOTE: You can prevent certain custom 
properties from being cleaned, for example, 
DMS Doc ID Properties, by specifying them in 
the Hidden Data Exclusions page. Refer to 
Hidden Data Exclusions, page 15.

Custom properties can be viewed in 
Microsoft Word by selecting Properties
from the File menu and then selecting 
the Custom tab.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All 
Document 
Variables

Microsoft Word only. If selected, deletes 
all document variables.

Document variables are values stored in 
Microsoft Word documents that are used 
by either field codes or macros to store 
various values. These variables may 
contain confidential information like 
company names, or file locations. Even if 
field codes and macros are removed, the 
variables used may remain in the 
document.

To view variables, open the Visual Basic 
Editor from Microsoft Word (Alt + F11).

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON
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Parameter Description Best Practice

Delete All 
Macros

Microsoft Word only. If selected, removes 
VBA macros from the document. This 
feature is not intended as virus 
protection, but rather to protect any 
confidential information, intellectual 
property or formulas included in the 
macros.

Macros can be viewed in Microsoft Word 
by selecting Macro and then Macros from 
the Tools menu.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete Routing 
Slip

Microsoft Word and Excel. If selected, 
removes all entries from a routing slip, as 
well as the message subject and text. 
This can prevent email addresses of 
colleagues from being unknowingly 
distributed. This also deletes any 
envelope information such as, recipients, 
subject and introduction, which are used 
when sending to a mail recipient.

Routing Slip entries can be viewed in 
Microsoft Word by selecting Send To and 
then Routing Recipient from the File 
menu. Envelope information can be 
viewed in Microsoft Word by selecting 
Send To and then Mail Recipient from 
the File menu.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Clear All 
Document 
Reviewers

Microsoft Word only. If selected, removes 
information about all document reviewers 
who have made changes in the document. 
Track changes are not removed, but 
information about the user who made the 
change is removed.

NOTE: Clearing reviewers but not track 
changes, may be useful if you are 
collaborating on a document with an external 
party who uses track changes. You can retain 
the actual track changes made in the 
document, but you can remove confidential 
information about the author within your 
organization that made the change.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

LOW RISK

Delete 
Footnotes

Microsoft Word only. If selected, removes 
any footnotes or endnotes included in the 
document.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON
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Parameter Description Best Practice

Convert Field 
Codes To Text

Microsoft Word, Excel and PowerPoint. If 
selected, converts any field codes that 
exist in a Microsoft Word document to 
text, for example, hyperlinks, table of 
contents, index. 

This prevents the field codes from being 
updated after you have distributed the 
document. It also prevents errors for 
fields that reference built-in or custom 
properties that have been removed.

NOTE: You can prevent certain field codes 
from being cleaned, for example, table of 
Contents or page numbers, by specifying them 
in the Hidden Data Exclusions page. Refer to 
Hidden Data Exclusions, page 15.

Field codes can be viewed in Microsoft 
Word by selecting Options from the Tools
menu and selecting Field Codes in the 
Show section of the View tab.

For Microsoft Excel and PowerPoint, 
hyperlinks are the only field codes that 
exist.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Reset Document 
Statistics

Microsoft Word only. If selected, resets 
all the document statistics - total edit 
time, revision number, last authors, and 
file dates.

Statistics and file dates can be viewed in 
Microsoft Word by selecting Properties
from the File menu and then selecting 
the Statistics tab.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Clear All Built-In 
Properties

Microsoft Word, Excel and PowerPoint. If 
selected, removes all summary properties 
- author, category, comments, company, 
keywords, manager, title, subject, and 
hyperlink base; and custom properties –
text, date and number.

Built-in properties can be viewed in 
Microsoft Word, Excel and PowerPoint by 
selecting Properties from the File menu 
and then selecting the Summary tab.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete All Excel 
and PowerPoint 
Headers

Microsoft Excel and PowerPoint. If 
selected, removes any headers included 
in the document.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON
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Parameter Description Best Practice

Delete All Excel 
and PowerPoint 
Footers

Microsoft Excel and PowerPoint. If 
selected, removes any footers included in 
the document.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Delete Smart 
Tags

Microsoft Word only. If selected, removes 
smart tags from Microsoft Word 
documents.

Smart tags are indicated in Microsoft 
Word by purple dotted lines underneath 
the words. Smart tags link functionality to 
special types of content, such as dates, 
names or addresses. For example, 
companies may have custom smart tags 
that provide a person’s telephone number 
whenever their name is typed. Smart tags 
may be recreated automatically by 
Microsoft Word when a document is 
reopened, if the smart tag is available.

Smart tags only exist in Microsoft Office 
XP and later.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Convert 
Attached 
Template To 
Normal

Microsoft Word only. If selected, converts 
the attached template to normal.dot. 
This does not affect the formatting of 
your document.

The attached template can be viewed in 
Microsoft Word by selecting Templates 
and Add-Ins from the Tools menu.

Internal

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = OFF

Profile #4 = OFF

External

Profile #1 = ON 

Profile #2 = ON 

Profile #3 = ON

Profile #4 = ON

Hidden Data Exclusions

The Hidden Data Exclusions policy includes parameters that enable you to exclude certain types of 
hidden data from being removed when documents are cleaned. The types of hidden data that can be 
excluded from cleaning are custom properties and field codes. When cleaning, the user can still 
select to clean custom properties and all custom properties or field codes will be cleaned, except 
for the ones explicitly excluded here.

It is important that any custom field codes used in an organization are reviewed for the sensititivy of 
information they may reveal.  Based on this analysis, any field codes deemed NOT to be a security 
risk can be excluded.

It is recommended that the Workshare Protect defaults for Hidden Data exclusions are suitable for 
most deployments.




